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Important
The following functions are for reference only. Some series products may
not support all the functions listed below.
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1 Network Config

1.1 Network Connection

Network camera and PC connection mainly has two ways, see Figure 1- 1 and Figure 1-2.

or cable

IPC
Figure 1- 1
<
e
N
i
i switch or
router
ol -
IPC
Figure 1-2

Before you access network camera via the Internet, you need to have its IP address. User can use
Config Tool to search IP of the network camera. Please refer to Config Tool manual.

1.2 Login

It needs to install WEB plug-in when you use WEB client for the first time, the exact operation steps are
shown as follows:

Open IE and input network camera address in the address bar. (The factory default IP address

is 192.168.1.108).

CAMERA
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After successful connection, the login interface is shown as in Figure 1-3; input your user name and
password. Default factory username is admin and password is admin.

Usemame: |admin

Password: |

Figure 1-3

The system will display flJpdate Passwordoprompt box for your first login, users need to modify the
password and save it properly.

First login, suggest updating password.

New Password I

Confirm Password

("] Don’'t show me again

Ok Cancel

Figure 1-4

After successful login, you may see the interface shown as in Figure 1-5.

CAMERA
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ER e LB BOE X L

Figure 1-5

Clickonfi Pl e a & leeretoldowaload and installthe plug-ind6. The system pops
information to ask you whether run or save this plug-in. See Figure 1-6.

CAMERA

Do you want to run or save this file?

Name: webplugin.exe
Type: Application, 1.08MB
From: 10.10.4.198

Run ][ Save I [ Cancel ]

‘ | While files from the Internet can be useful, this file type can
| ! /) potentially harm your computer. If you do nat trust the source, do not
=~ un or save this software. What's the risk?
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Figure 1-6

You must either run or save the file to local and install it. Follow the following steps. Click on run, you
will see Figure 1-7and Figure 1-8.

Ready to Install
Setup is now ready to begin instaling webplugin.exe on your computer.

Click Install to continue with the installation.

l, Install ] l Cancel

Figure 1-7
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Installing
Please wait while Setup installs webplugin.exe on your computer,

Registering files...

Cancel

Figure 1-8

When plug-in installation completes, the installation page closes automatically. The web-end will
refresh automatically, and then you can view video captured by the camera.

n Sub Stream 1 substeam2 JICRJTCF =l = B 1

v @8 E DN O

Figure 1-9
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2 Live

After you logged in, you can see the live monitor window. See Figure 2-1.

alhua
1 [_an siam L5002 B 080

Figure 2-1

There are four sections:

> Section 1: Encode setup bar
Section 2: System menu
Section 3: Window function option bar

Section 4: Window adjust bar

2.1 Encode Setup

Note: Some seriesdond t s wspbsteeant 2.
The encode setup interface is shown as in Figure 2-2.

Sub Stream 1 Sub Stream 2 BRI« m

Figure 2-2

Please refer to the following sheet for detailed information.

CAMERA
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Parameter Function

Click it to enable main stream video monitoring and click again
to disable it. Generally for storage and monitor.

Click it to enable Sub Stream1 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Click it to enable Sub Stream 2 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast

Main stream

Sub Stream 1

Sub Stream 2

Protocol

2.2 System Menu

System menu is shown as in Figure 2-3.
Please refer to chapter 2 Live, chapter 3 PTZ, chapter 4 Playback, chapter 5 Setup, chapter 6 Alarm,
chapter 7 Log out for detailed information.

[ e T = T pawecc | sewp | mam | togout |

Figure 2-3

2.3 Video Window Function Option

The interface is shown as below. See Figure 2-4.

Figure 2-4

Please refer to the following sheet for detailed information.

SN Parameter | Function
1 Relay-out It shows if there is any alarm output, status description is as
follows:

> Red: means there is alarm output.
> Grey: means alarm is over.
Click on the button to force alarm to be on or off.

CAMERA
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2 Digital > When the video is in the original status, click it you can
Zoom select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.
> Click it; you can use the middle button of the mouse to
zoom in/out the video size.
3 Snapshot Click on the button to snapshot, save picture to path in Ch
5.1.2.5.
4 Triple Click it to take snapshot upon the video at the frequency of
Snapshot one picture per second. All images are saved to path in Ch
5.1.2.5.
5 Record Click it to record the video. All videos are saved to path in
Chapter 5.1.2.5.
6 Easy focus | Click it, you can see there are two parameters on the preview
video' AF Peak and AF Max.
AF Peak: It is to display the video definition during the focus
process.
AF Max: It is the most suitable value for the video definition.
The close the AF Peak and AF Max is, the better the focus
effect is.
7 Audio Turn on or off audio when you are monitoring.
8 Talk Click it to start or end bidirectional talk.
9 Help Click it to open help file.

2.4 Video Window Setup

The interface is shown as in Figure 2-5.

2.4.1 Image Adjustment
See Figure 2-6 for image adjustment.

CAMERA
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Image Adjustment

| 64

Figure 2-6

Click this button to display/hide image control interface. Click it to open picture setup interface. This
interface is on the top right pane.

Please refer to the following sheet for detailed information.

Parameter Function

Video It is to adjust monitor video Note:

setup brightness. > All the operations here apply
to WEB end only.

It is to adjust monitor video

Please go to Setup-

contrastness. >Camera->Conditions to
ﬂ It is to adjust monitor video adjust corresponding items.
hue.
e It is to adjust monitor video
saturation.

Reset | Restore brightness,
contrastness saturation and
hue to system default setup.

2.4.2 Original Size
Click this button to go to original size. It is to display the actual size of the video stream. It depends
on the resolution of the bit stream.

2.4.3 Full Screen
Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.
9
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2.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

2.4.5 Fluency Adjustment
There are three levels of fluency for you to select (Realtime, Normal, and Fluency). The default is
normal.

2.4.6 Rules Info
Click the button, preview image will display intelligent rules after enabling; it is fenableoby default.
2.4.7 Zoom and Focus
Click this button and the focus zooming interface appears on the right of preview interface, as shown in
Figure 2-7, click left mouse button to adjust focus zooming configuration. Note:

¥ The product series which support motorized zoom, synchronous focus and back focus have
this button.

¥ Auto-focus after zoom and focus adjustment.
2.4.8 Fisheye/Trigger Track
Click the button, installation mode and display mode interface will show up on the right of the preview
interface, see Figure 2-8 and Figure 2-9, single click to switch different installation mode and display
mode, or different display modes, it is enabled by default.
Note:
It is only supported by some models.

Zoom and Focus

Zoom Speed Ej

Zoomin

Focus Speed m

B-f—n
Near

Far

7} Auto Focus
Restore All
Refresh

Regional Focus

Figure 2-7

10
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Parameter | Function
Adjust the focal length of the lens by clicking or long pressingfiéido but t ons .
Zoom
Step length is used to adjust the length of one step with one click.
Adjust the sharpness of the lens by clicking or long pressingi@& 0 butt ons.
Focus
Step length is used to adjust the length of one step with one click.
Click to adjust the image definition automatically.
Auto- Note:
focus
Other lens operations are not allowed during the process of auto-focus.
Reset the lens to zero position to eliminate the accumulative error of lens.
Reset All Note:
Please reset when the image adjustment is not clear or operating zoom focus many
times.
Refresh Synchronize the location of drag slider of lens and zoom focus after hardware zoom
focusing.
Regional Click it and use the mouse to select a zone, then the device can auto focus within the
Focus specific region.

VA

In-ceiling Mount Wall Mount Ground Mount

Installation Mode Installation Mode

Installation Mode

CAMERA
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Figure 2-8

parameter

Note

Installation Mode

Three modes which are ceiling mount, wall mount and ground mount.

Display Mode

It represents the display mode of the current image (default supports original
image mode), the display modes may be different according to different
installation modes. It is shown as follows:

Ceiling: 1P+13a 2Pa 1+2a 1+3a 1+4a 1P+6a 1+8A
Wall: 1Pa 1P+3a 1P+4a 1P+8A
Ground: 1P+13 2Pa 1+3a 1+4a 1P+63 1+8A
Note:
The default displays original image mode when switching installation mode.

In-ceiling/Wall/Ground

O

It menas the original image without de-warpping

In-ceiling/Ground

Original
image
360°expanded rectangular panorama + independent
sub image, the sub image and the subbox in the
expanded rectangular panorama support zoom and

1P+1 movement, for the expanded rectangular panorama
also supports left and right starting point movement.

Two related 180°expanded rectangular pictures, two
subwindows form 360° panorama anytime, which is
N also called idual Oop.a n o rTe expanded
—p rectangular pictures both support left and right
movement starting point, which are also linked by
eachother.

Original image + 2 independent sub images, both the
sub image and the subbox in the original image
"(Jj support zoom and movement. The original image also
1+2 | supports changing starting point by rotation (no such
display mode for ground installation).

Q|

Original image + 2 independent sub images, both the
Q sub image and the subbox in the original image
143 support zoom and movement. The original image also
supports changing starting point by rotation

Original image + 4 independent sub images, both the
QH_ sub image and the subbox in the _o_rigin_al image

1+4 | supportzoom and movement. The original image also
supports changing starting point by rotation

CAMERA
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parameter

Note

1P+6

360°expanded rectangular panorama +6 independent
sub image, both the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

3]

1+8

Original image + 8 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

Wall

1P

From left to right 180° expanded rectangular
panorama, which supports up and down movement
and changes vertical angle of view.

180°expanded rectangular panorama+3 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

1P+4

180°expanded rectangular panorama+4 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

1P+8

180°expanded rectangular panorama+8 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

Display Mode

Al IR
.......ll'

Figure 2-9

Enable the trigger track on the interface of tripwire or intrusion, and draw the rule of tripwire or
intrusion, the scene of trigger track window will change according to the moving object when it triggers
rule alarm until the moving object disappears from the view range of the camera. Please refer to i6.3.4
IVSofor more details about the rules drawing and parameter config of tripwire and intrusion. Trigger
track includes three modes which are 1P, 1P+3 and 1P+5.

CAMERA
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> B 1P: Original picture

ee trigger track windows on the original picture.

1P+3: Original picture and three trigger track windows, it can adjust the location and size

1P+5: Original picture and five trigger track windows, it can adjust the location and size of

five trigger track windows on the original picture.

CAMERA
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3 PTZ Control

Here you can view direction keys, speed, zoom, focus, iris, preset, tour, scan, pattern, aux on, off and
PTZ setup button. See Figure 3-1.

Note:

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please refer to Ch 5.5.3).
Currently only IPC-HFXXXX series and i PT series products can support PTZ function.

Parameter Note

> PTZ supports eight directions: left/right/up/down/upper left/upper
right/bottom left/bottom right.

It controls rotation speed. The longer the step length, the higher the speed.
Step length control PTZ, zoom, focus and iris.

Use mouse to draw a box in monitoring video, PTZ will rotate and focus to
Quick Position | quickly positioning.

PTZ direction

Speed

000
0®o0
000
speed(1-s) [
©: 0
0
-0

PTZ Seftings

Cooe]

Figure 3-1

15
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000
0®o
00O

speed(1-5): [FjE

© O

© O
© -0

PTZ Settings

Figure 3-2
PTZ setting interface is shown as in Figure 3-3.
Here you can set scan, preset, tour, pattern, assistant function and light and wiper plus view coordinate.

PTZ Settings

3.1 Scan

Scan interface is shown in Figure 3-4.

16
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PTZ Settings

P Start H Stop

& Set

Set Left Set Right

Figure 3-4

Steps to scan are:

Set Left Set Right icon.

Step 1. Click on Set button, display

Step 2. Move via direction key to select left, click on Set Left to set left border of camera
Step 3. Move via direction key to select right, click on Set Right to set right border of camera.
Step 4. Complete scan path setup.

3.2 Preset

Preset interface is shown in Figure 3-5.

Q Goto

& Set Preset

+ Add

Figure 3-5
Steps to preset are:
Step 1. In preset box, input preset value.
Step 2. Click on Go to, camera rotates to preset position.
Step 3. Use direction key to rotate camera, and in preset box input preset value.
Step 4. Click on Add to add a preset. Range of preset relates to PTZ protocol.

3.3 Tour

Tour interface is shown in Figure 3-6.

CAMERA
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PTZ Settings

ErEErS

Figure 3-6

Steps to tour are:

Step 1. In tour box, input tour path value.

Step 2. Click on Add. Range of tour relates to PTZ protocol.

Step 3. In preset box, input preset value.

Step 4. Click on Add as to add a preset in this tour. If click on Del, it deletes this preset in tour.
Note:

You can add more than one preset here, or delete more than one preset.

3.4 Pattern

Pattern interface is shown in Figure 3-7.

PTZ Settings

ER—

5
EETE

Figure 3-7

Steps to set pattern are shown as follows:

Step 1

Input pattern serial number value in the box, click i A @ dhdhit will display i St arot afh&t o pd .Re ¢
Step 2

Clickiin St arot tReci mpl ement a series of operioaandsons such a
on. Step 3

Clickin St opd Reoc compl ete the setting of a pattern path.
Step 4

18
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Clicki Stoaratnd it will start pattern accordimgtoomntdhe p
the pattern ends.

3.5 Assistant

Assistant interface is shown in Figure 3-8.

PTZ Settings

Figure 3-8
Steps to assistant are:
Step 1. In assistant box input assistant value.
Step 2. Click on Aux On to turn on aux function.
Click on Aux off to turn off aux function.

3.6 Light Wiper

Light wiper interface is shown in Figure 3-9.

PTZ Settings

Light Wiper

Enable Disable

Figure 3-9
Steps to light wiper are:
> Click on Enable to enable light wiper function.

Click on Disable to disable light wiper function.

19
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4 Playback

Web client playback supports video playback and picture playback.
Note:

Before playback, user shall set storage management as in Ch. 5.4.

4.1 Playback

The playback interface is shown as in Figure 4-1.

SD Card

< IS >
Sun Mon Tue Wed Thu Fri Sat

1
21314)5)6)7]8
9110 11 12 13 14 15
1617 18 19 20 21 | 22

23242526 27 28 29

=)

00000 O 1=

Record Type Al General B Motion I Alarm Manual B . . m

Figure 4-1

There are four sections:
> Section 1: Function of play
Section 2: Playback file
Section 3: Play time cut
Section 4: Record type
Section 5: Progress bar

Section 6: Assistant function

CAMERA
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4.1.1 Function of Play
The function of play is shown as in Figure 4-2 and Figure 4-3.

00000 O =0

O 6e® 6 6 O 61

Figure 4-2

00000 O =8

D e® 6 ® O @2

Figure 4-3

Parameter Function

When you see this button, it means pause or not played record. Click on this

Play button, switch to normal play status.

Stop Click this button to stop playing.

Click on this button to go to next frame.

Play by frame Note:
You shall pause record when you use this function.

Slow Click on this button to play slowly.
Quick Click on this button to play quickly.
Silent When this button displays, it means audio is silent. Click on this button to
switch back to normal.
Volume Click on left mouse to adjust volume.
_ -1 Fisheye Click this button and fisheye device can adjust display mode according to

different installation mode during the process of playback.

Click the button and it will playback and display intelligent rules and object
- -2 Rule Info detection box if the video is equipped with intelligent rule info after the
function is enabled, it is off by default.

21
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4.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 4-4.

< 2013 [

Sun Mon Tue Wed Thu Fri Sat

1l2l3lals5]6]7
8 10 11 12 13

15 17 [48] 19

22 24 25 26

29 3

Figure 4-4
Parameter Function
) Selectiday as video playback.
File Type L s .
Selectijgpgas picture playback.
Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green
represents normal record, yellow represents motion detect record, red represents alarm record,
and blue represents manual record.

Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 4-5.

Figure 4-5

Step 3. Click on file list = select date file will be displayed in list.

Step 4. Double click on file in list, playback this file and display file size, start time and end time.
See Figure 4-6..

22
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00 : 00 : 00 - 23 : 59 : 59 jfe}
General, Event, Alarm, Manual

Download Format @ dav © mp4

Start Time  File Type
15:49:39 =] 0
15:50:07
15:54:38 |
16:25:13
16:31:35
16:32:06
16:45:58
16:54:00

OO0 O0000

17:00:54

<171 » v KN D
Begin Time:
End Time:

File Size:

Figure 4-6
Parameter Function
nSearch It means records within searched start time and end time on the date.
Download _
Format There are two formats: dav, mp4.

CAMERA
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Parameter Function
E . click the download button and download file to path in Ch. 5.1.2.5.
Download System does not support download and playback at the same time.

& Back Click on back button to go to calendar interface.

4.1.3 Playback Cut
Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be

at the same time.
Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

Pr——

LY lv
Step 2. Move mouse to cut icon A‘ﬁ . You will be ask to select start time. Click on cur icon &),Qi
as finish cutting.

Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.

0 Y
Step 4. Move mouse to cut icon& you will be asked to select end time. Click on cut icon .Ei
as finish cutting.
Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 4-7.

00:00:00 - 00:00:00 D

Figure 4-7

4.1.4 Record Type

After checking record file type, only selected file will be displayed in progress bar and file list. Users can
also select the record type to be displayed via the dropdown box which is above the file list. See Figure

4-8.

RecordType [MAI [dGeneral @ [dMotion @ [Alarm ™ Manual W

Figure 4-8

4.1.5 Progress Bar
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(O 30min

Figure 4-9

Parameter Function

O 24hr 24 hours Click on it, means video in past 24 hours.

O2znr |, hours Click on it, means video in past 2 hours.
®1hr 1 hour Click on it, means video in past 1 hour.
(D 30min 30 min Click on it, means video in past 30 min.

4.1.6 Assistant Function
Video playback assistant function is shown in Figure 4-10.

Figure 4-10

Parameter Function

Digital Zoom restore its original size.

Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, Right mouse click to

Click on this button, you can scroll to zoom in.

Snapshot will be saved to path in Ch. 5.1.2.5.

[z] Click on this button, you can snapshot video under playback status.
Snapshot

4.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar
2 Playback file bar
3 Snapshot type bar

CAMERA
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See Figure 4-11.
ua

TECHNOLOGY

[>)

Snapshot Type All General W Event M Alarm

4.2.1 Play

Figure 4-11

oo

Figure 4-12

File Type jpg
Data Src SD Card

< IECIEH >

Sun Mon Tue Wed Thu Fri Sat
1lzl3]als]ls]7
8|9 101112 13] 14
15| 16 17 {8 8 [20] [2i]
22| 2324|2526 27|28

29130 31

Default icon is m and it means pause or not played picture. Click on play button to switch to

normal play status. Ilcon become m

Click on it to pause.
4.2.2 Playback File

CAMERA
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< e

Sun Mon Tue Wed Thu Fri Sat

112134567

8 1011112113 14

15 17 19 20 21

22 26 27 28

29

Figure 4-13

Step 1. Click on file list ¥
Step 2. Double click on file in list, to play this snapshot.

, select snapshot file of the date.

Parameter Function

n Search It means all snapshot files within the start time and end time of selected date.

CAMERA
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Parameter Function
E Click the download button to open snapshot file or directly download to local
Download according to the browser types.
& Back Click the back button to return to calendar interface and re-select time.

00 : 00 : 00 - 23 : 59 : 59 jfe}

Start Time  File Type
13:23:16 O
13:24:55
13:25:09
13:25:19
13:25:29
13:25:40
13:25:50
13:26:09
13:26:19
13:27:41
13:27:51
13:28:01

®
(&)

N
I cleReNeNeNelelleRe e

)

M <€1/1p P

Figure 4-14

4.2.3 Snapshot Type
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After checking snapshot file type, in file list only display file of selected type. Users can also select the
snapshot type to be displayed via the dropdown box above the file list. See Figure 4-15.

Snapshot Type All General | Event W Alarm

Figure 4-15
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5 Setup

Web client setup support camera, network, time, storage, system and system info view.

5.1 Camera

The camera setting includes conditions, profile management, zoom and focus.

5.1.1 Conditions

Note:

The camera parameter may be different according to different models, please refer to the actual

product for more details.

5.1.1.1 Picture

Note:

The device which supports true WDR fails to support long exposure when true WDR is

enabled. Step 1

Select fSetup > Camera > Conditions > Picturedand the system will display the fPicturedimage which

is shown in Figure 5-1.
aJhua

Conditions

Profile Day

> Video

> Audio

' Style ' Standard B
Network = : = y;Expostire Brightness (=]

Event . = » Backlight Contrast [Z]

0
0
Saturation (=] O 50
0
0

Storage b » WB
System ) » Day & Night

: g Sharpness [=]
Information 4 » IR Light

Gamma (=]
Mirror ©) ON @ OFF

Flip 0° [+]

Default ] I Refresh | | Save

Figure 5-1
Step 2
Set picture parameters; please refer to the following sheet for more details about parameter setting.
Parameter Note
Style It is to set the picture style, which includes standard, soft and vivid.
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Parameter

Note

Brightness

It is to adjust the image overall brightness via linear adjustment mode.
The larger the number is, the brighter the picture is, and on the contrary it

is opposite. The picture get blurry easily when the value is set too big.

Contrast

It is to adjust the picture contrast. The bigger the value is, the bigger the
bright contrast becomes, and on the contrary it is smaller. The dark area
becomes darker and the bright area becomes overexposed easily when
the value is set too big. The picture becomes blurry when the value is set
too small.

Saturation

It is to adjust the color darkness and lightness. The color becomes darker
when the value is bigger; on the contrary it becomes lighter. The value
causes no influence to the overall brightness of the image.

Sharpness

It is to adjust the sharpness level of the picture edge. The bigger the
sharpness value is, the more obvious the image edge becomes, the image
is likely to generate noise more easily when the value is set too big.

Gamma

It is to change image brightness and improve the dynamic display range of
the image via nonlinear adjustment mode. The bigger the value is, the
brighter the picture becomes, and on the contrary it is opposite.

Mirror

After mirror is enabled, the monitoring image will be displayed invertedly.

Flip

It is to change the display direction of the monitoring image.
It includes following options:
Normal: The monitoring picture is normally displayed.

Flip mode 1: The monitoring picture is displayed with clockwise
rotation 90£

Flip mode 2: The monitoring picture is displayed with anticlockwise
rotation 90£

180£ : The monitoring picture is displayed upside down.
Note:

Please set the video resolution as 1080P or lower when applying flip mode
for some devices.

EIS

It can realize electronic anti-flicker function via comparison algorithm of
image difference, which can effectively solve the problem of image jittering
during application and it can make the image clearer.

Step 3

Click isaveoand complete the image parameter config of the camera.
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5.1.1.2 Exposure
Step 1
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Select fSetup > Camera > Conditions > Exposurea The system will display the fFExposureodinterface

which is shown in Figure 5-2.

> Video

> Audio
Network
Event
Storage
System

Information

Profile Normal

» Picture

Anti-flicker Outdoor

Mode Auto

] [E]

» Backlight Autolris @ ON () OFF
» WB

3DNR@ ON ) OFF

Grade [=] U 50

» Day & Night
» IR Light

Figure 5-2
Step 2
It is to set the exposure parameter, please refer to the following sheet for more details.
Parameter Note
> You can switch to exposure mode when it is in outdoor
mode, it can realize the result in the corresponding exposure
mode.
> B50Hz: When the current is 50Hz, system can auto adjust the
Anti-flicker

exposure according to the environment brightness in case
there is any stripe.

5

60Hz: When the current is 60Hz, system can auto adjust the
exposure according to the environment brightness in case

there is any stripe.
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Parameter

Note

Mode

It is the camera exposure mode.
Note:

5

When fAnti-flickerois fOutdorg the fexposure modedcan be set as
fgain priorityoor fshutter priorityomode.

Different devices have different exposure modes; please refer to the
actual interface.
It includes the following options:

5

Auto: It can auto adjust the image brightness according to the
environment.

Gain priority: The device can auto adjust according to the gain
range which is set by priority during normal exposure

range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to

reach the effect and the gain value has reached to upper limit
or lower limit, which is to make the image reach the best
brightness.

> Shutter priority: The device can auto adjust according to the
shutter range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the shutter value has reached to upper
limit or lower limit, which is to make the image reach the best
brightness.

> Iris priority: Iris value is fixed, the device can auto adjust the
shutter value if the image brightness fails to reach effect and
the shutter value has reached the upper limit or lower limit,
the device can auto adjust the gain value to make the image
reach the best brightness.

* Manual: It is to manually set gain value and shutter value,
adjust the the displayed brightness of the image.

Auto Iris

It can set the parameter when the camera installs auto iris.

> The lens iris can auto adjust the size according to the
environment after auto iris is enabled, then the image
brightness will change accordingly.

The iris value reaches the max when disabling auto iris, the

lens iris will not change according to the environment
brightness.

5

3D NR

It is to process the image with multiframe (at least two frames), it
can realize noise reduction of the image by using the interframe
information between the previous and latter frame.

Grade

It can set the parameter when | 3D NRL is enabled.
The bigger the grade is, the better NR effect it can realize.
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Step 3
Click iSaveoto complete the parameter config of camera exposure.

5.1.1.3 Backlight

Backlight mode can be divided into BLC, WDR and HLS.

BLC: it can avoid cucoloris phenomenon of the darker area in the backlight environment.

WDR: It can suppress the overbright area and compensate darker area by enabling WDR, which can
make the overall image clear.

HLC: It is to weaken the high light, which can be applied in the areas such as toll gate, entrance and
exit of the parking lot and etc. As for extreme light, it can snapshot the human face in the dark
environment and it can realize better effect for the details of the plate number.

Step 1

Select fSetup > Camera > Condition > Backlightg the system will display the interface of iBacklightd
which is shown in Figure 5-3.

Profile Normal

s
> Audio ' B » Picture Wode | OFF E

Network e z . - - » Exposure
storage ; - N e
System 3 » Day & Night

Information » IR Light

| Default ‘ l Refresh | | Save I

Figure 5-3
Step 2
Set the backlight parameter.

5

When the fModedis set as fiScene Self-adaptationg the system will auto adjust the image
brightness according to the environmental brightness, which is to make the object display clearly
in the scene.

When the fModedis set as fBLCQ it can select default mode or customized mode.

When selecting fDefaultomode, the system can realize auto exposure according to the
environment, which is to make the image in the darkest area clear to be seen.
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-

When selecting lCustomizeddomode, the system can realize exposure upon the selected area
after it set customized area, which is to make the image of the selected area reach
appropriate brightness.

5

When the Modeois set as AWDRQ it will lower the brightness of the area with high brightness and
enhance the brightness of the area with low brightness, which is to make the objects in both high
brightness and low brightness area display clearly.

Note:
There may be video loss of a few seconds when the camera is switched from non WDR mode to
WDR mode.

5

When the fModeod is set as FHLCQ the system will constrain the brightness of the area with high
brightness and decrease the size of the halo area, which is to lower the brightness of the whole

image.
Step 3
Click iSaveoto complete the config of the backlight mode.

5.1.1.4 WB
WB is used to restore the white object in the scene by the camera, after WB mode is set, it can
make the white object look white in different environments. Step 1

Select fSetup > Camera > Conditions > WBQ the system will display the interface of AWBQ which is
shown in Figure 5-4.

| Zoom and Focus

> Profile Normal E
> Video

s 5 ;
> Audio 5 —_— Litcucs Mode | Auto B

Network B BERCSs e - » Exposure

Event - - » Backlight

System » Day & Night

Information » IR Light

Figure 5-4
Step 2
Set WB mode.
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When the Modeois set as fAutoq the system can auto compensate white balance upon
different color temperatures, which is to make the image color normal.

When the Modeois set as fiNaturalg the system can auto compensate white balance to the
scene without artificial light, which is to make the image color normal.

When the Modedis set as fStreet LampqQ the system can auto compensate white balance to the
outdoor scene at night, which is to make the image color normal.

When the fModeois set as fOutdoorq the system can auto compensate white balance to the most
outdoor scenes with natural light and artificial light, which is to make the image color normal.

When the Modeois set as fManualq it can manually set the value of red gain and blue gain;
the system can compensate the different color temperatures in the environment according to
the settings.

When the MModedis set as fRegional Customgq it is to set customized area, the system can
compensate white balance to different color temperature of the images in the area, which is
to make the image color normal.

Step 3
Click fsaveoto complete the config of WB mode.

5.1.1.5 Day & Night
It is to set the switch between color mode and black & white mode.
Step 1

Select fSetup > Camera > Conditions > Day & Nightoand the system will display the interface of fDay
& Nightg which is shown in Figure 5-5.

Conditions

Profile | Normal
> Video

B i y
> Audio oAl bt Mode |Auto

Network o — " = HE L Sensitivity| Middle

Event s — » Backlight Delay 6S

Storage = g " » WB

system » Day & Night

Information » IR Light

| Default I | Refresh I | Save I

Figure 5-5
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Step 2

Set day & night parameter; please refer to the following sheet for more details.

Parameter

Note

Mode

It is to set the camera image displayed as color or black & white mode.
Note:
The settingofi Day / Ni gohti sMondoet af f e c tAePdr ohlf yi
Managemento .
It includes the following options:

Color: The camera image is displayed as color image.
> Auto: The camera can auto select color image or black & white image

to be displayed according to the environmental brightness.
Black & white: The camera image is displayed as black & white image.

Sensitivity

The parameter can be set when the I' Day/Night Model. is| Autol .
It is to set the sensitivity of the switch between image color display and
black & white display.

Delay

The parameter can be set when the I' Day/Night Model. is| Autol .

It is to set the switch delay between image color display and white & black
display. The smaller the delay is, the faster of the switch becomes between
color display and black & white display.

Step 3

Click isaveoto complete the config of day/night mode.

5.1.1.6 Defog

The image quality will become weak when the device is in the environment with fog or haze, you

can enable defog function to adjust the image definition. Step 1

Select iSetup > Camera > Conditions > Defogodand the system will display the interface of fDefogo
which is shown in Figure 5-6.
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Profile| Day
> Video

> Audio . ' » Picture Mode | OFF B
Network B et 4 B » Exposure

Event s » Backlight

Storage e A » WB

System » Day & Night

A
o5

I Default ] l Refresh l | Save |

Figure 5-6
Step 2
It is to set defog mode according to the actual scene.

5

When the fModeo is set as Manualg it is to manually set intensity and air light mode, the
system will adjust the image definition according to the intensity and air light mode which have
been set previously. As for air light mode, you can set manual or auto.

When the PModeois set as MAutoq the system will auto adjust the image definition according to
the actual scene.

> When the fModeois set as fOffg then the defog function is disabled.

Step 3
Click isaveoto complete the config of defog mode.

5.1.1.7 IR Light

You can directly set the mode of IR light if the device is equipped with IR light.
Step 1

Select fSetup > Camera > Conditions > IR Lightdand the system will display the interface of AR
Lightowhich is shown in Figure 5-7.

CAMERA

38



@hua

> Audio
Network
Event
Storage
System

Information

Step 2
It is to set

5

Dahua Network Camera Web 3.0 Operation Manual

Profile Normal
» Picture Mode | SmartiR E}
» Exposure
» Backlight
» WB
» Day & Night
» IR Light
Figure 5-7

IR light mode according to the actual scene.

When the Modeois set as fManualq it can manually set the brightness of IR light; the system will

realize light compensation to the image according to the IR light intensity.

When the AModeois set as fSmart IRG the system can adjust the light brightness according to the

actual scene.

> When
the br

E

5

Step 3

the Modeois set as izoomprioq the system can auto adjust the IR light according to
ightness change of the actual scene.

The system will enable near light by priority when the actual scene becomes dark, the system
will enable the far light when the near light fails to meet the requirement of scene brightness
even if it is adjusted to the brightest.

The system will adjust far light brightness by priority to off and then adjust the brightness of
near light when the actual scene becomes bright. The system will always disable far light
when the focal length of the lens is adjusted to a certain wide angle, which is to avoid near
overexposure. Meanwhile, it can manually set light compensation to slightly adjust the
brightness of IR light.

When the fmodeois set as fOffq it will not enable the IR light.

Click isavedand complete the config of IR light.
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5.1.1.8 Profile Management

Step 1

Select fiSetup > Camera > Conditions > Profile Managementoand the system will display the interface of
fProfile Managementa

Step 2

Set profile management.

5

Whtfa_n the fProfile Managementd 1 s fNoemalg the system will monitor according to the normal
config.

@hua ez Lopymec | seve | aam [ tosout

Camera Conditions Profile Management Zoom and Focus @

Profile Management & Normal ¢ Full Time ¢ Schedule

> Video

> Audio Defaut. | [ Refesn | |
Network

Event
Storage
System

Information

Figure 5-8

When the fProfile Managementois set as iFull Timeq you can select fAlways Enableoin fDayoor
fNight§ the system will monitor according to the config of falways enablea

@hua

Camera Conditions Profile Management Zoom and Focus

Profile Management € Normal ¢ Full Time ¢ Schedule

Always Enable Day ]'

> Video
> Audio

Network | Default [ | Refresh I |

Event
Storage
System

Information

Figure 5-9

5

When the fProfile Managementois set as fiScheduleq you can set some period as day and another
period as night, for example, if it sets 0:00~12:00 as day, 12:00~24:00 as night, then the system
will monitor by adopting corresponding config in different periods.
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@hua

Camera Conditions Profile Management Zoom and Focus

0
Profile Management ¢ Normal € Full Time  Schedule
> Video

> Audio

e poasetns (L e ———
Event 0:00 4:00 8:00 12:00 16:00 20:00 24:00
Storage E Day M Night

SfStom Default | | Refresh I | Save |

Information

Figure 5-10
Step 3
Click fsaveoto complete the settings of profile management.
Note:

Click fDefaultoto restore the device to default config; click fRefreshoto check the latest config file of the
device.

5.1.1.9 Zoom and Focus

Note:

Only motorized vari-focal devices support focus and zoom function.

Step 1

Select fSetup > Camera > Conditions > Zoom and Focusoand the system will display the interface of
fZzoom and Focusowhich is shown in Figure 5-11.

@ieg TR N (I (R ST ST
©)

Camera Conditions

Profile Management Zoom and Focus

> Video

> Audio
Network
Event
Storage
System
Information

zoom WiE (=) () TELE Speed [20 ~ Restare All

Focus NEAR (= () FAR  Speed [20 ~| | C+JAutoFocus Refresh

Figure 5-11
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Step 2

Adjust the focal length of the lens.

After it is zoomed, set fSpeedodand press fi+q it
adjust. Step 3

Adjust the lens definition.

After it is focused, set iSpeedodand press firgq i odrag the sliding block directly to adjust.
Note:

> Speed is used to set the length by pressing firoand fifi

fi odrag the sliding block directly to

> After adjusting the focal length of the lens or click fAuto Focusg the device will auto adjust
the image definition, it is not allowed to implement other lens operation during auto focus.

> After several times of zoom and focus, the image fails to be adjusted clear, click fRestore All6to
reset the lens to zero and remove the accumulative error of the lens.

Click fRefreshoand the device will automatically synchronize the hardware to the location of
sliding block of lens zoom and focus.

5.1.2 Video

5.1.2.1 Video

Step 1

Select fSetup > Camera > Video > Videooand the system will display the interface of fivideoowhich
is shown in Figure 5-12 or Figure 5-13.

Video Snapshot Overlay

> Conditions

- Video 7 Main Stream Sub Stream

Network Enable Sub Stream 2 v
Event Encode Mode H.264H v Encode Mode H.264H v
Storage Smart Codec OFF v ®/ Resolution D1 (704*480) v
System Resolution 2304x1296 (23041296 ¥ Video Clip
LT Frame rate(FPS) |30 v Framerate(FPS) |6 v
Bit Rate Type CBR v Bit Rate Type CBR v
Reference BitRate  1792-10240Kb/S Reference BitRate  48-896Kb/S
Bit Rate 6144 v BitRate 896 v
| Frame Interval 60 (30~150) | Frame Interval 12 (6~150)

| Watermark Settings

Watermark Character | DigitalCCTV

Default I | Refresh ] l Save

Figure 5-12 (Non fisheye)
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Snapshot Overlay

2C0on: Installation Mode Ceiling E|
o Vo Record Mode 2P E|
> Audio
Network Main Stream Sub Stream
Event [v] Enable Sub Stream 1 [+]
Storage Code-Stream Type | General [+] Code-Stream Type | General El
System Encode Mode H.264 = Encode Mode H.264 [~]
Information Heaoimon 2432x2432 (2432.2432)5 Resolution 640x640 (640%640) E|
Frame rate(FPS) 15 [+] Frame rate(FES) 15 [=]
BitRate Type CBR = Bit Rate Type CBR [~]
Reference BitRate  2048-11008Kb/S Reference BitRate  256-1792KbiS
Bit Rate 8192 [+] R 1024 [=]
| Frame Interval 30 (15~150) | Frame Interval 30 (15~150)
sve 1(off) [~] v 1(off) [=]
(V] Watermark Settings
Watermark Character | Digital CCTV
Default l | Refresh | | Save

Figure 5-13 (Fisheye)
Step 2
Set video bit stream, please refer to the following sheet for more details about the parameters.

Parameter Function

It will display the parameter when the device is fisheye.
There are three installation modes for fisheye which are
ceiling, wall mount and ground installation, please
select installation mode according to the actual
installation scene of the fisheye.

The system will begin to switch after switching
installation mode, it will prompt successfully saved after
it is switched successfully.

Note:

The device end will output the dewarped video stream
after configuring installation and record mode, when the
device is accessed to third-party platform, it will directly
display the dewarped image on the third-party platform.

Installation Mode
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Parameter

Function

Record Mode

It will display the parameter when the device is fisheye.
The system will begin to switch after record mode is
switched, it will prompt saved successfully after it is
switched successfully.
The record mode will change according to the different
installation modes.
> 10: the original picture which is not dewarped.
1P: 360£ rectangular panorama.
2P: The mode can be set when the finstallation
Modeois set as Ceilingoor fGrounda It is the 2
related 180£ rectangular image, the two
subwindows can both form 360£ panorama
anytime.
10+3R: original image + 3 independent sub
images, both the sub image and sub boxes in the
original image can support zoom and movement.
1R: Original image + independent sub image, the
sub boxes of the original image support zoom and
movement.
4R: original image + 4 independent sub images,
both the sub image and sub boxes in the original
image support zoom and movement.
2R: Original image + 2 independent sub images,
the sub boxes of the original image can support
zoom and movement, the sub image supports up
and down movement, which can change the
vertical angle of view.
Note:
The device end will output dewarped video stream after
configuring installation and record mode, when the
device is accessed to the third-party platform, it will
directly display the dewarped image on the third-party
platform.

Sub Stream Enable

Select fEnableoto enable sub stream.
The device supports enabling sub stream 1 and sub
stream 2 at the same time.

Smart Codec

It can enhance image compression performance and
reduce storage space by enabling intelligent encoding.
Note:

After intelligent encoding is enabled, the device will not
support third stream, ROI or intelligent event detection,
please refer to the actual interface for more details.
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Parameter

Function

Encode mode

There are five options: H.264 (main profile standard,
H.264H (high profile standard), H.264B (Baseline
Profile), H.265 (main profile standard) and MJPEG
encode.
The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.
The H.265 is the main profile encode mode.
MJPEG: In this encode mode, the video needs to
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommend bit to get the better video output effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Video Clip

The function is only supported by sub stream 2, please
refertoi Vi deo fCoi pmore detail

Frame Rate (FPS)

PAL: 1" 25f/s° 1-50f/s NTSC: 1" 30f/s or 1~60f/s.
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MJPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

Bit Rate

In CBR, the bit rate here is the max value. In
dynamic video, system needs to low frame rate or
video quality to guarantee the value.

The value is null in VBR mode.

Please refer to recommend bit rate for the detailed
information.

SVvC

Frame rate can be encoded by layer. It is a flexible
encoding method. By default, it is 1 as 1 layer. You also
can set 2/3/4 layers.

| Frame

Here you can set the P frame amount between two |
frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.
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Parameter Function

Watermark Settings Selecti Wat er mardk aSred temagb|l e w
function. After the watermark function is enabled, you
can check if the video is tampered via verifying
watermark character.

Watermark Character It is the character of watermark verification, it is
Digital CCTV by default.

> Video Clip
1. Selectfi 8bStream20 i n t-down baoxyclickfi En adb. | e

F . X
2. Enableii Vi deo, C" " pck
The system will display the interface of i Aroe,a whi ch i s s-bMown in Figure 5

Area X

Resolution D1 (704*480) E’ Save Cancel

Figure 5-14
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3. Select the needed resolution and clip the needed image on the interface, which is shown in Figure

5-15.
4. ClickfiSaov.e You can c he ednthelpreview interfage &he sub strdam 2 preview
interface only displays the clipped area), which is shown in Figure 5-15.

Figure 5-15

Step 3
Click fsaveoto complete video stream setup.

5.1.2.2 Snapshot
The snapshot interface is shown as in Figure 5-16.

@Jhua

Video

Snapshot

> Conditions

> Audio

Snapshot Type | General v
Image Size 1080P (1920%1080)

Quality |5 v
Network _—
Interval 18 V.

Event ‘

Storage Default I I Refresh I l Save.

System

Information

Figure 5-16
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Please refer to the following sheet for detailed information.

Parameter Function

Snapshot type There are two modes: general (schedule) and Event (activation).
Image size It is the same as the resolution of main stream.

Quality It is to set the image quality. There are six levels.

Interval It is to set snapshot frequency. Optionall~7s/picture, customized.

5.1.2.3 Video Overlay
The video overlay interface is shown as in Figure 5-17.

| (O™ O Enable © Disable
5 | » Channel Title
> Audio
» Time Title
Network . - S
Event - - - B » Text Overlay
Storage - » Picture Overlay
System » » Counting

Information

|TemoveAll || Delete |(OrRigh1click)

[ Defat ][ Refiesh || Save

Figure 5-17
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@lhua

> Conditions

Storage
System

Information

Defaut || Refiesh | sae

» Privacy Masking @ Enable

» Channel Title Input channel title:

» Time Title IPC

» Text Overlay

, » Picture Overlay

» Counting

() Disable

@Jhua

> Conditions

> Audio

Network

» Privacy Masking

® Enable Disable

» Channel Title Week Display

Event - = . i has » Text Overlay

Storage S » Picture Overlay

System

Information

Defautt || Remesn ||

» Counting

Figure 5-19
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> Conditions

» Privacy Masking (O Enable © Disable

,) " . » Channel Title Input Text:
o
o » Time Title
& >

Event . s [

Storage 4 ~ » Picture Overlay

System Y Sy

Information
Text Align
Right =]

> Conditions

> Audio

) Enable © Disable

» Privacy Masking
» Channel Title Picture Preview:
» Time Title
Network

» Text Overlay
Event

System - » Counting

Information

Upload Picture

Requirement for picture upload
1. Max size is 16k.

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.

Figure 5-21
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@Jhua

> Conditions

e

B . » Channel Title Statistics Type
Audi

- » Time Title [v] Enter Number

Network
» Text Overlay [V] Leave Number
Event

i Text Ali
Storage = » Picture Overlay ign

5 - Left

Information

Figure 5-22
Please refer to the following sheet for detailed information.
Parameter Function
Privacy Masking | . Here you can privacy mask the specified video in the

monitor video.
System max supports 4 privacy mask zones.
Time Title . _You can_enqble_ this fu_nction so that system overlays time
information in video window.
You can use the mouse to drag the time tile position.
Channel Title ~ Youcan _enable t_his _fun_ction SO that system overlays
channel information in video window.
You can use the mouse to drag the channel tile position.
You can enable this function to overlay text in video
window.
Private protocol is connected to mobile NVR, support GPS
information overlay.
You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.
Picture Overlay | .  You can enable this function to display overlay picture.
Click on disable to turn it off.
Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.
Note:
You cannot enable text and picture overlay at the same time.

Text Overlay
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Counting Check fEnableoto display the counting statistics data in
the video monitoring window; check fDisableonot to
display.

There are enter number and leave number for statistics
type and left align and right align for OSD info.

Refresh Set privacy mask, channel title, ti_me title, location, overlay
and save the change. You can click on Refresh to see
effect.

Default Click it to restore default config.

Save Click it to complete video settings.

5.1.2.4 ROI

Note: Some series dond support ROI setup function.

Snapshot

Enable '@ Disable

> Audio

Image Quality | 6(best) ¥

LT
Event
Storage
System

Information

| Remowear |[  Deete | orRightlick)

[ Default ] [ Refresh ] [ Save

Figure 5-23
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@Jhua

Camera Snapshot Path

> Conditions

> Audio

Enable e Disable
Image Quality |6(best) ¥
Network
Event
Storage
System

Information

Remove All Delete {Or Rightclick )

| Default | 1 Refresh | I Save

Figure 5-24
Parameters | Note
Enable Checkfi En adb,| e¢ hen it wi hthevideo mgnitoeng wihdbwe R O]
Check it Dabled, t hedt idi svpmlnay .
Set the image quality of ROI, ranging from 1" 6, default is 6.
Image Note:
Quality For fisheye device, it ranges from 1~6 (best), default is 6 (best)
Able to set area block, max 4 areas.
5.1.2.5 Path

The storage path interface is shown as in Figure 5-25.

Here you can set snap image saved path and the record storage path.
> The default monitor image path is C:\Users\admin\WebDownload\LiveSnapshot.
The default monitor record path is C:\Users\admin\WebDownload\LiveRecord.

5

The default pla{back snapshot path is C:\Users\admin\WebDownload\PlaybackSnapshot.
The default playback download path is C:\Users\admin\WebDownload\PlaybackRecord.

The default playback cut path is:
C:\Users\admin\WebDownload\VideoClips. Note:
Admin is locally logged in PC account.

Please click the Save button to save current setup.
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Snapshot

Live C:\U in\WebDownload\LiveSnapshot
Live Record C:\Users\admin\WebDownload\LiveRecord Browse...

> Audio
Playback Snapshot  C:\Users\admin\WebDownload\PlaybackSnapshot Browse...
Network

Event Playback Download  C:\Users\admin\WebDownload\PlaybackRecord Browse...
ven

{11}

Video Clips C:\Users\admin\WebDownload\VideoClips Browse...
Storage

System Default | { Save
Information

Figure 5-25

5.1.3 Audio

Please note some series devices do not support audio function.
5.1.3.1 Audio

The audio interface is shown as below. See Figure 5-26.

v L rapack | sewp | aam | _toout ]
©)

Audio

> Co
> Video — Encode
Main Stream
Network [v] Enable
Event Encode Mode G.7T1A [~]
Storage Sampling Frequency | 16k B
System
Information SubStroam
[C] Enable Sub Stream 1 B
Encode Mode G.711A
Sampling Frequency | 16k E
—— Affribute —
Audioln Type Lineln
Noise Filter Enable [+]
WMicrophone Volume (=] O 50
SpeakerVolume =] D 50
Default ’ l Refresh | | Save |

Figure 5-26

Please refer to the following sheet for detailed information.
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Parameter

Function

Enable

You can enable audio only when video is enabled.

After selectingthe i En adb loef mai n stream
network transmission stream is the audio/video composite
stream, otherwise it only includes video image.

Encode mode

The encode mode of the main stream and extra stream include
G.711A, G.711Mu, G.726 and ACC. The default mode is
G.711A.

The setup here is for audio encode mode and the bidirectional
talk encode both.

Sampling The sampling frequency of audio. It includes the following
Frequency options:
8K
16K
32K
48K
, 64K
Audioln Type Two modes to select: Lineln, Mic.
Device needs to connect external audio input source under
Lineln mode, and it doesnd need to connect external audio
input source under Mic mode.
Noise Filter Enable the function and it can filter relevant noise.
Microphone Adjust microphone volume from 0° 100.
Volume

Note:
Supported by some devices.

Speaker Volume

Adjust speaker volume from 0" 100.
Note:
Supported by some devices.

5.1.3.2 Alarm audio

CAMERA
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@Jhua

Alarm Audio

> Conditions

> Video

Network

@« alarm1.pcm

@ alarm2.pcm ()]

Event
Storage
System
Information

Figure 5-27
Add Audio File X
i Record ¢ Upload
Audio File | pcm
Record
Figure 5-28

Audio management currently supports PCM format to record and PCM, wav two forms to upload

and can select an audio file for the audio alarm linkage.
The way to download the web alarm playback audio file into local is as follows:

Step 1 Use the left mouse button to click the hollow circle “inthefich @i c® ! umn

@ . . . . .
and shows =~ which means effective choice of alarm audio.

on

Step 2 Use the right mouse button to click x- selectisave tdartgoetdoawn!| oad.

5.2 Network

5.2.1 TCP/IP

The TCP/IP interface is shown as in Figure 5-29. It supports IPv4 and IPv6. IPv4 supports static IP
and DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB will
automatically jump to the new IP address.

CAMERA
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@hua

Camera TCP/IP

> Connection Ethernet Card

Host Name

> PPPOE Wode

> DDNS MAC Address
> IP Filter IP Version

> SMTP(Email) IP Address

> UPnP

Subnet mask
> SNMP

Default Gateway

> Bonjour

Preferred DNS Server, 8 8

> Multicast

Alternate DNS Server | 8 8 4

> WIFI

IPC

Wire(DEFAULT) <

@ static © DHCP

172 . 29 2 36
2585 . 255 0
172 . 29 0
8

0
1
8
4

IV Enable ARP/Ping to setIP address senvice

> 802.1x

> QoS
Event
Storage
System
Information

Default ‘ \ Refresh } i Save

Figure 5-29
Please refer to the following sheet for detailed information.
Parameter Function
Host Name It is to set current host device name. It max supports 15

characters.

Ethernet Card

Please select the Ethernet port. Default is wired.

Please note you can modify the default Ethernet card if there is
more than one card.

Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.

IP Version It is to select IP version. IPV4 or IPV6.

You can access the IP address of these two versions.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS

DNS IP address.

Alternate DNS

Alternate DNS IP address.
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Enable You can use ARP/Ping command to modify or set the device
ARP/Ping set IP address if you know the device MAC address.
device IP

, Before the operation, please make sure the network camera
address service. | and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the
PC in the same LAN.

Step 2: Get the physical address from the label of the
network camera.

Step 3: Go to the Run interface and then input the following
commands.

arp i s <IP Address> <MAC>
ping 114807t <IP Address>
Suchas arp-s192.168.0.125 11-40-8¢-18-10-11
ping -1 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output informationsuchasi Reply from 162. 168. 0. 125
from the command output lines. Now you can close the
command line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

5.2.1.1 Easydip

Click fEnableoto connect the device to network, and then you can connect to the device via mobile

client of Easy4dip afteri On l0i mes di spl ayed on the interfacemberconnect |
or scan QR code). See Figure 5-30.

@lhua

Camera TCP/IP Easydip

TGPIP. [] Enable

C

> Connection Status Offline

> PPPoE

SIN 1K037FCPAWD00213
> DDNS

QR Code
> IP Filter

> SMTP(Email)

> UPnP

st \ Default | | Refresh

Save

> Bonjour

> Multicast

> 802.1x
> QoS

> HTTPs
Event

Storage

System

Information

Figure 5-30
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5.2.2 Connection

5.2.2.1 Connection

The connection interface is shown as in Figure 5-31.

@Jhua

Camera

> TCPi
___ Connection
> PPPoE
> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour
> Multicast
> 802.1x
> QoS
> HTTPs
Event

Storage

System

Information

Connection

Max Connection 10 (1~20)

TCP Port 37777 (1025~65534)
UDP Port 37778 (1025~65534)
HTTP Port 80

RTSP Port 554

HTTPs Port 443

Default J | Refresh [ | Save

Figure 5-31
Please refer to the following sheet for detailed information.
Parameter | Function
Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.
TCP port Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.
UDP port | Port range is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.
HTTP port | Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.
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RTSP port

5

The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

> Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

> User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

HTTPs
Port

HTTPs communication port, range is 1025~65534, default is 443.

Note:

* 0 1024, 37780 37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.

> Avoid using default port value of other ports.

5.2.2.2 ONVIF

ONVIF Open Network Video Interface Forum
interface, data type and data interaction mode. ONVIF Standardé s ai m i sa networkavidelo i

this standard describes network video mode,

frame agreement and makes the network video products (including video front-end, video
equipment, etc.) from different manufacturers completely compatible.

ONVIF function is on by default.

CAMERA
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@lhua

Camera Connection ONVIF

> TCPIP Authentication ® ON () OFF

Default | l Refresh | |

> PPPoE
> DDNS
> IP Filter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs
Event
Storage
System

Information

Figure 5-32

5.2.3 PPPoE
The PPPoOE interface is shown as in Figure 5-33.
Enter the PPPoE username and password which are provided by ISP (Internet Service Provider), and

clicki Enadb.l eThe network camera wil!/| a lectionrmahe meda of PRPoOEe st ab | i
after it is enabled, after it is successful, the IP of thei | P Addmwédd be automatically m
into the dynamic IP address of the acquired WAN.

Note:

After PPPOE dial-up is successful, it needs to log in the device via the IP which is set before dial-up; in
the PPPOE setup interface, it will display the registered IP address, and then it can visit the IP address
via client.

Please disable UPnP when clicking PPPoE enable, which is to avoid causing influence to PPPoE dial-
up.
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@hua

Camera PPPoE

Ne Tk _
. [C] Enable
> TCPAP
Usemame
> Connection

PPPOE
> DDNS petaut__ ][ Refresn

Password

> IP Fitter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS
Event
Storage
System

Information

Figure 5-33

5.2.4 DDNS

The DDNS interface is shown as in Figure 5-34.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN,
you should disable UPnP.

ua
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Camera DDNS

3 TCPIP [C] Server Type Dahua DDNS [~]

> Connection Server Address

> PPPoE Mode o Auto ) Manual
Domain Name 2 .dahuaddns.com
> IP Filter Username (Optional)Please input the mailbox
> SMTP(Email)
Default l ! Refresh ] [ Save

> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs
Event

Storage

System

Information

Figure 5-34

Please refer to the following sheet for detailed information.
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Parameter

Function

Server Type

You can select DDNS protocol from the dropdown list: CN99
DDNS, NO-IP DDNS, Dyndns DDNS, Dahua DDNS, the default
is Dahua DDNS.

Server Address

DDNS server IP address

CN99 DDNS

Server address: www.3322.0rg

NO-IP DDNS

Server address: dynupdate.no-ip.com
Dyndns DDNS

Server address: members.dyndns.org
Dahua DDNS

Server address’ www.dahuaddns.com

Mode

Default is auto, able to choose manual

Domain Name

Both auto and manualare A MAC addr esss.

default, able to set prefix manually.

dadlyu

Username

The user name you input to log in the server, optional.

The CN99 DDNS interface is shown as in Figure 5-35.
@hua

[7] Server Type
> TCPIP
Server Address
> Connection
Domain Name
> PPPOE

> IP Filter

Usemname
Password

> SMTP(Email) Ypdaie Renod

> UPnP

> SNMP
> Bonjour
> Multicast
> 802.1x
> QoS
Event

Storage

System
Information

CAMERA

CN99 DDNS

none
none
LYYy

10 Minute (1~500)

Detautt || Retesn || save

Figure 5-35
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Parameter Function

Server Type You can select CN99 DDNS protocol

Server Address | Under CN99 DDNS the default server address is Ainww.3322.0rgo

Domain Name | Self-defined domain name

Username The user name you input to log in the server.

Password The password you input to log in the server

Refresh Period

is 10 minutes.

The refresh period of the connection between the device IP and the server, default

5.2.5 IP filter

The IP filter interface is shown as in Figure 5-36.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.
You can add IP address or IP segment.

If you do not check the box here, it means there is on access limit.

Here you can add IP address and MAC address. You must add these addresses before enabling

the trusted sites.

Please note: You must set MAC address in the same network segment.

IP Filter

Network Trusted Sites
> TCPAP

Trusted Sites

> Connection

> PPPoE

> UPnP
> SNMP
> Bonjour

> Multicast

— s

> QoS

I Default | \ Refresh | \ Save
Event

Storage

System

Information

Figure 5-36

5.2.6 SMTP”™ e-mail)
The SMTP interface is shown as in Figure 5-37.
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Camera SMTP(Email)

Network

SMTP Server none
> TCPAP

Port 25
> Connection -

[¥] Anonymity

> PPPoE

Username
> DDNS
> IP Filter Password

__ SMTP(Emai) Sender none

Z e Authentication None [
> SNMP

Title [V] Attachment
> Bonjour

Mail Receiver
> Multticast
> 802.1x
> QoS
Event Interval 0 Second (0~3600)
Storage [7] Health Mail Update Period Second (1~3600)
System

~ Email Test
Information
| Default } | Refresh 1 | Save

Figure 5-37

Please refer to the following sheet for detailed information.

Parameter Function

SMTP Server

Input server address and then enable this function.

Port Default value is 25. You can modify it if necessary.

Anonymity For the server which supports the anonymity email function, it
wonét display the information

User Name The user name of the sender email account.

Password The password of sender email account.

Sender Sender email address.

Authentication You can select SSL, TLS or none.

(Encryption

mode)

Title (Subject)

Input email subject here.

Attachment

System can send out the email of the snapshot picture once
you check the box here.

Mail receiver

Input receiver email address here. Max three addresses.
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Parameter Function
Interval The send interval ranges from 0 to 3600 seconds. 0 means

there is no interval.

Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Please check the box here to enable this function.

Health mail
enable
Email test The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.
5.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.

Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable

UPNP function. See Figure 5-38.

In the Windows OS, From Start->Control Panel->Add or remove programs. Clickthei Add/ Remov e
Windows Componentsd and t hem Nedlweoatk otSleer wimc ¢ & e odnemtd Wirasd. Co m
Click the Details button and then checkthefil nt er net Gat eway Devi ceodadd scovVv e
AUPNP Usero.l nttleerafsaececl i ck OK t o begin installation.
Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto
detectitviathei My Net woa k Pl aces

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port

mapping without user modification.
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EQLUL]

Camera

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Fitter

> SMTP(Email)

> SNMP
> Bonjour

> Multicast

UPnP

Dahua Network Camera Web 3.0 Operation Manual

e | rm ] rame ] sews | _sem ] _iogow ]

> 802.1x

[] Enable Mode | Manual E' Router State Mapping Failed
Port Mapping List
Service Name Protocol Internal Port External Port Status Modify
¥ HTTP WebService:TCP 30 8080 Mapping Failed 4
[V TCP PrivService:TCP 37777 37777 Mapping Failed &
= uDP PrivService:UDP 37778 arTTs Mapping Failed 4
] RTSP RTSPService:TCP 554 554 Mapping Failed &
Defauit | | Refresh | | Save

> QoS
Event

Storage

System

Information

5.2.8 SNMP
The SNMP interface is shown as in Figure 5-39 and Figure 5-40.
The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or

establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.

ELUL]

Camera

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> Bonjour
> Multicast
> 802.1x
> QoS
Event

Storage

System

Information

SNMP

SNMP Version

SNMP Port
Read Community
Write Community
Trap Address

Trap Port

Figure 5-38

[C] SNMPv1 [C] SNMPv2 [T] SNMPv3
161 (1~65535)
public

private

162

Figure 5-39

Please refer to the following sheet for detailed information.
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Parameter Function

5

SNMP Version Check SNMP v1, device only process v1 info.

> Check SNMP v2, device only process v2 info.
Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.

SNMP port The listening port of the proxy program of the device. Itis a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Community Itis a string, as command between management and proxy, ,
defining a proxy,andamanagerd6 s aut henti cat

Read-only access to all SNMP targets, default is public.

Note: Only number, letter, , and i supported.

Read/write access to all SNMP targets, default is private.

Note: Only number, letter, , and i supported.

Trap address The destination address of the Trap information from the
proxy program of the device.

Read community

Write community

Trap Address Address where to send Trap message.

Port which send Trap message, default is 162, range

Trap Port
1~65535.

@hua

Camera SNMP
Network

> TCPIP .

> Connection SNMP Port 161 (1~65535)

SNMP Version SNMP v1 SNMP v2 [V] SNMP v3

> PPPoE Read Community public
> DDNS Write Community private
> IP Fitter Trap Address
> SMTP(Email)
> UPnP

> Bonjour Authentication Type @ MD5 SHA

Trap Port 162

Read-only Usermname public

> Multicast Authentication Password
> 802.1x Encryption Type © CBC-DES

> Qos Encryption Password

Event —
Stocage Read&write Usemame | private

System Authentication Type @ MD5 SHA
Information Authentication Password

Encryption Type © CBC-DES

Encryption Password

Detaut ][ Reesn ][ sae

Figure 5-40
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Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port
are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need
to configure parameter in chart.

Parameter Function

SNMP Version | SNMP v3

Read-only ﬁg{:ult is public.

Username Name only can be number, letter and underline.
Read/Write ﬁg{:ult is private.

Username Name only can be number, letter and underline.
Authentication | You may select MD5 or SHA, default is MD5.
Authentication Password not less than 8 characters.

Password

Encryption Default is CBC-DES.

Encryption Password not less than 8 characters.

Password

5.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 5-41.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera
device and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the fDisplay All Bookmarks: and open the Bonjour, system
can auto detect the network camera of the Bonjour function in the LAN.

@hua

Camera
Network

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Fiiter

> SMTP(Email)
> UPnP

> SNMP

> Muiticast

> 802.1x

> QoS
Event
Storage
System
Information

CAMERA

Bonjour
[¥] Enable

Server Name PZC1EW24200002

pefaut__||

Refresh | | Save
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Figure 5-41

5.2.10 Multicast

The multicast interface is shown as in Figure 5-42.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data
packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host
can just send out one data to transit. This function also depends on the relationship of the group
member and group of the outer.

Note:

B

Open preview, streaming media protocol, select multicast, and monitor via multicast format.

Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.

Multicast

Main Stream

Sub Stream

> TCPAP = =

[v] Enable V| Enable

> Connection
Multicast Address 224 1 2 4 | (224.0.0.0~239.255.255.255) Multicast Address 224 1 2 4 | (224.0.0.0~239.255.255.255)

> PPPoE

Port 40000 (1025~65534) Port 40002 (1025~65534)
> DDNS

> IP Filter

> SMTP(Email) petaut_ || Retresn [ save

> UPnP

> SNMP
> Bonjour
> 802.1x
> Qos
Event
Storage

System

Information

Figure 5-42

Please refer to the following sheet for detailed information.

Parameter Function

Enable Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0° 239.255.255.255.

Port Multicast port. Main stream is 40000, sub streaml is 40016,sub stream2 is
40032 and the range is 1025 65534.

5.2.11 4G

70

CAMERA



Calaya Dahua Network Camera Web 3.0 Operation Manual

Note: This function is only for series with 4G module.
4G is a mobile communication system which makes wireless communication integrates with Internet

and multimedia communication.

5.2.11.1 Dialing Setting

Camera Dialing Setting

Network

> TCPIP Wireless Net Type Auto

> QoS

Event

Mobile Settings

E] [v] Enable

Information

> Connection APN 3gnet
> DDNS Authorize Mode No E]
> IP Filter Dial-up Number *99%#
> SMTP(Email) Username
> UPnP Password
> Homion Update Period 30 =aced
> Multicast Time Range
_ Wireless Network State
IP Address
Storage Wireless Signal WCDMA 0%
System FDD-LTE ) 70%
Default | l Refresh I | Save
Parameter Function

Wireless Net Type

Auto, WCDMA, FDD-LTE optional, you can select according
to the operator.

Enable

Check to enable 4G module.

APN

It shall be acquired from the operator according to the setup
of operator.

Authentication Mode

Auto, PAP and CHAP, the authentication algorithm is
different according to different operators.

Dial-up Number

The number is different according to different operator, it can
be acquired from operator.

User name

It shall be acquired from the operator.

Password

It shall be acquired from the operator.

Update Period

It is the period beyond the dial-up period which has been
set, it is 30s by default, which means the device can auto
acquire 4G dial-up status, cut off dial-up to save flow.
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Time Range It is the time period to set dial-up. It can activate the function
via message to enable/disable dial-up function if it is
beyond the time period.

IP Address It will display the acquired IP after the dial-up is successful

via 4G.

5.2.11.2 Mobile Setting
ua

TECHNOLOGY

Camera Dialing Setting

Ne ork

> TCPIP [7] Message Send

> Connection Receiver
> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> Bonjour

> Multicast

> QoS

Event

Storage

System

Information

Mobile Settings

[T] Message Activation [7] Phone Activation

T Sender T Caller 2

Title Event Message

Defautt || Refresn || Save

Figure 5-44

Please refer to the following sheet for detailed information.

Parameter

Function

Message Send

In the event, after the corresponding message activation is
enabled, it will send message to the phone of receiver when
event happens. It needs to enable the function of message
activation function in the event interface when using the
function.

Message
Activation

It can send message ON/OFF to the SIM card inside the device by
the mobile phone in the list, which is to enable /disable the dial-up
function and send REBOOT to restart the device.

Phone Activation

You can use the mobile phone in the calling list to call the SIM card
inside the device to enable dial-up function.

5.2.12 WIFI

CAMERA
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Note:
Some series devicesdond6t support WIFI and WPS function.
WPS function is supported by the devices with WPS button.

5.2.12.1 WIFI

WIFI info can show the name, status, IP information of the Current Hot Spot. Usually please fRefresho
WIFI work information after reconnection to ensure the real-time display of the work status, because it
often takes some time to connect WIFI Hot Spot, which depends on the network signal strength.

WIFI

I” Enable

> TCPAP
1D List

> Connection
> PPPoE -
> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast >

SWEL | [ wiRro

> 802.1x Current Hot Spot
> QoS IP address
Event Subnetmask
Default Gateway

Storage

System

Information

Figure 5-45

WIFI setting method is as follows:

. ¥ Enable . .
Step 1 Click Sl show as " means enabling WIFI function.

Step 2 Click fiSearch SSIDg and shows the wireless network hot spot of the current network
camera environment in the list.
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ua

ELUTTE]

Camera

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS
Event
Storage
System

Information

WIFI

¥ Enable

12345
5370test
TP-LINK_465EF6
AndroidAP
TP-LINK_425796
NETGEARG4

TP-LINK_NUJIAN

Dahua Network Camera Web 3.0 Operation Manual

Add SSID

H Search SSID 1

WPA-PSK-AES
WPANPA2-PSK-TKIP+AES
WPA-PSK-TKIP+AES
WPAZ-PSK-AES
WPANPA2-PSK-TKIP+AES
NONE

WPANWPA2-PSK-TKIP+AES

WIFI INFO

CurrentHot Spot  unconnected

IP address
Subnetmask
Default Gateway

Figure 5-46

the figure below, and enter network ID in the dialog box.

¥

Step 3 Click MAdd SSIDowhen need to add a wireless network manually pop out an interface in

Add Wireless SSID

SSID

Ok

Cancel

Figure 5-47

Step 4 Double click on one can pop out the signal intensity and authentication of the hot spot.

Please enter the password if necessary. Please keep the choice of password index number

same as the router when entering password.

Please clicki c o nd eic ft

5.2.12.2 WPS
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 Enter PIN
PIN:

> Connection

SSID

> PPPoE

> DDNS

> IP Filter

€ Button

Status disconnected

> SMTP(Email) Connecting I I Refresh
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

Event

Storage

System

Information

Figure 5-48
PIN Number and SSID are both acquired from the router, please fir e for eeshhe wor k i nf or mat
to ensure the real-time display of work state after filling in correctly.
5.2.13 802.1x
802.1x (port based network access control protocol) supports manual selection of authentication
method to control if device connected to LAN can join the LAN. It well supports authentication,
charging, safety and management requirement of network.

(TN ST gy (TR SRVTTIR ST
)

802.1x

[7] Enable
Authentication PEAP [=]

Usemame none

> TCPAP
> Connection
> PPPoE
> DDNS

Password oo

> IP Filter Defauit | | Refresh | l Save
> SMTP(Email)

> UPnP
> SNMP
> Bonjour
> Multicast

> QoS

Event

Storage

System

Information

Figure 5-49

Please refer to the following sheet for detailed information.
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Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
5.2.14 QoS

The QoS interface is shown as below. See Figure 5-50.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission
bandwidth, delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the
delay, and reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level O is the lowest, and level 63 is the highest. It can also discard at
the different ratio when the broad bandwidth is jam.

@Jhua

Camera QoS
Network ;
Realtime Monitor 0 (0~63)

> TCPAP
Command 0 (0~63)
> Connection

EARRRLE ] l Refresh I | Save
> DDNS

> IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour
> Multicast
> 802.1x
(oo |
Event

Storage

System

Information

Figure 5-50
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can
monitor provide different service for various data packets.
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Parameter Function
Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.
Enable Check it to enable QoS.
Wireless QoS
5215 HTTPs

In the HTTPs setting interface, users can make PC log in normally via HTTPs by creating certificate
or uploading signed certificate, which is to guarantee the security of communication data and provide
safeguard for user information and device security with reliable and stable technical means. Step 1

Create certificate or upload the signed certificate.

> Please refer to the following steps if you selectii Cr e at e
1. Selecti Set up
shown in Figure 5-51.

@lhua

Camera
Network

> TCPAP

[ Enable HTTPs

> Connection Create Certificate

> PPPOE
> DDNS

> IP Filter

Request Created

Request Created

> SMTP(Email)

> UPnP
> SNMP
> Bonjour
> Multicast
> 802.1x

> Qos

Event
Storage

System

Certificate Path

Certificate Installed

Aftribute

Information

>

Certificate Key Path

Certificate Installed

Install Signed Certificate

Refresh

Gertificate
Net wor and HR&Psystem wil]l

Browse...

Browse... |

I

2. Clickii Cr edataen d

CAMERA
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Figure 5-51
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HTTPs X

Country CN "0 CN

IP or Domain name | 10.15 15 211| } .

Validity Peniod 365 Day*Range :1-5000

Frovnce none
Location none
Organization none

Qrganizasion Unit none

Emall

Creal Cancel

Figure 5-52
3. Fillin correspondingfi Coumfi RPryo wi mae some ot herf drnédbactadmtae i ofi, | Ic
in. It will show the promptof A Cr eat e Soccehsfcthl mpgans the server ¢
successfully created.

Note:
Make surethein | P or d odrsahie same as that of the device.
4. Clickil néetahd it wil/l install the certi fgure558.e on t he
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@lhua

Camera

> TCPIP [”] Enable HTTPs

> Connection Create Certificate
ZHDRS Request Created
> IP Filter
Request Created
> SMTP(Email)
Install Signed Certificate

> UPnP
> SNMP Certificate Path
> Bonjour Certificate Key Path
> Multicast Certificate Installed

> 802.1x

Event

Certificate Installed

Attribute

Issue to: HAP=10.15.15.211; C=CN; ST=none;
L=none; O=none; OU=none; EM=;
Issuer: HAP=test; C=CN; ST=test, L=test, O=test,  ~

Dahua Network Camera Web 3.0 Operation Manual

Delete | | I | Download

SIOERGE Refresh

| | Save

System

Information

Figure 5-53
5. Clicki Do wna .o allghop owmt the dialog boxof f Savé, asave the file into
& Save As - ]
@‘U'[‘H » Libraries » v | &,‘ | Search Libraries pe) ‘
Organize v gE - @
Deskt: - : :
B Desktop _ Libraries
# Downloads !5 Open a library to see your files and arrange them by folder,...
=1 Recent Places ‘_
— & Documents
4 - Libraries S Library
5| Documents -
JV Music ﬁ Music
@ b
b [i5] Pictures ~ Library
B Videos
= Pictures
‘92 Library
4 (M Computer e il
> &, Local Disk (C:)
I = DISK1_VOL2 (D)

»  DISK1_VOL3 (E)

File name: RootCert.cer

Save as type: [(".cer)

“ Hide Folders

CAMERA

J |

Save Cancel ]

Figure 5-54
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6. Double click the downloaded iconofi Root Cért Thersystem will displ ay
information interface of i C e r t o \Whickciashosvn in Figure 5-55.

Certificate @

General IDetails I Certification Path |

@g Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: test

Issued by: test

valid from 2016/ 7/ 8 to 2020/ 7/ 7

[ o ]

Figure 5-55
7. Clickiil nstal |0 Cend iifti cvaitlel poipCeorutti ftihcea tian,tlewdioarctte Wifz
is shown in Figure 5-56.
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Certificate Import Wizard

Welcome to the Certificate Import

Wizard

certificate store.

This wizard helps you copy certificates, certificate trust
lists, and certificate revocation lists from your disk to a

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where

certificates are kept.

To continue, dick Next.

o1
v 1]

[ Next > ] [ Cancel ]

8. Click i N edx t

CAMERA

Figure 5-56
S altusted Root Certification Authoritieso |,

wib shawh in Figure 5-57.
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costese g et e

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specdify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
@ Place all certificates in the following store
Certificate store:

Trusted Root Certification Authorities

Learn more about certificate stores

| <Back | mNext> | | cancel |

Figure 5-57
9. Clickii Nedxt The system will AcCiosnpll &y ithlye tihret €refrod,¢ ¢ i ¢fat
which is shown in Figure 5-58.
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e

Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have specified the following settings:

Certificate Store Selected by User BRI =s Ll &= g]ile
Content Certificate
< T} »

| <Back || Fmsh | | concel

Figure 5-58
10.Clickin Fi oaj shnd it wil |l pofpSeocuutr itthye Wiaihanlcangg i bso xs-B@ofwn i
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Se;urity Warning

You are about to install a certificate from a certification authority (CA)
:Li claiming to represent:

test

Windows cannot validate that the certificate is actually from "test". You
should confirm its origin by contacting "test". The following number
will assist you in this process:

Thumbprint (shal): 6D811FD2 E82313A8 663514ED 2CA36EGB 7D425FA6

Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security risk. If you click "Yes" you acknowledge this
risk.

Do you want to install this certificate?

Yes No
Figure 5-59
11.Clicki'Yes It will pop folump arhte Sy cadidodgs flboolxc oconipl et e dow
certificate, which is shown in Figure 5-60.
B 2 Bl
Certificate Import Wizard @

) The import was successful.

L ,
Figure 5-60
: Please refer to the following steps if you selectii | nst al | Signed Certificate
1. Selecti Setup > NetworKhe 8yIPem will display the int

shown in Figure 5-61.
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@Jhua

Camera

> TCPIP [T] Enable HTTPs

> Connection Create Certificate
PRI Request Created
> IP Filter
Request Created ] | | \ Download

> SMTP(Email)

Install Signed Certificate
> UPnP
> SNMP Certificate Path e Browse...
> Bonjour Certificate Key Path Browse... | Upload |
> Multicast Certificate Installed
R0z Certificate Installed :
> QoS

Attribute

Event

Storage Refresh || Save

System

Information

Figure 5-61
2. Select signed certificate and certificate key path respectively viafi Br odw,s edé Uip ¢do. a d
3. Install root certificate, please refer to step 6~11 for more details.

4, CheckiEnabl eo HTdBiaw.e The system will @NeptHatvyothebdo!
the deviceb, and then the config is valid.
Reboot

ﬂ The configuration takes effect, the device is restarting now, please don't leave this page or close the browser...

Figure 5-62
5. Use HTTPs Use
HTTPs to log in.

Enter https://xx.xx.xx.xx in the browser, and it will pop out normal login interface; the browser will
prompt certificate error if the certificate is not installed, which is shown in Figure 5-63.
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Ol - (€ hitps//101515211/

N

File Edit View Favorites Tools Help

Y Favorites | g [B B v ) MTTSAE v

‘ /& Certificate Error: Navigation Blocked

[@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server.

We recommend that you close this webpage and do not continue to this website.
@ Click here to close this webpage.

"iﬂ Continue to this website (not recommended).

& More information

Figure 5-63
Note:
AXXx.x0Y. Xxs. x0orresponding to your | P or domain name.
5.3 Event

5.3.1 Video detection

5.3.1.1 Motion Detection

Step 1

Select iSetup > Event > Video Detection > Motion Detectiondand the system will display the interface
of Motion Detectionowhich is shown in Figure 5-64.
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TECHNOLOGY

Camera Motion D ion Video Tamp
Network
Event [C] Enable
S
> Audio Detection
Anti-Dither 5 Second (0~100)
> Smart Plan
> Face Detection [¥] Record
> People Counting Record Delay 10 Second (10~300)
LR V] Relay-out
Zadamn Alarm Delay 10 Second (10~300)
> Abnormality .
{1 Send Email
Storage
[] Snapshot
System
Information Default I | Refresh | \ Save
Figure 5-64
Step 2
Select fEnableoto enable motion detection function.
Step 3

Set motion detection area.

1. Click fSetupoand the system will pop out the interface of fSetting Areag which is shown in Figure
5-65
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Area

™~
Region =] o =

Name [ Region1 ‘

sensitivity (=) —————{_}——(3) 60
Threshold (=) {}—————(@) 5

Figure 5-65

2. Set area name, it is to set valid area of motion detection according to the actual situation, and it

can set the value of sensitivity and threshold respectively.

The bigger the sensitivity is, the easier it is to generate motion detection, the smaller the threshold is,
the easier it is to generate motion detection; the entire video image is the valid area of motion

detection by default.

Note:

: Different colors represent different areas; each area can set different detection area.

> The red line in the Oscillogram means triggering motion detection; green line means not

triggering motion detection.
3. Click fSaveoto complete area setting.

Step 4

It is to set other parameters of motion detection, please refer to the following sheet for more details.
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Parameter

Function

Working Period

Note:
It is to set the alarm period, it can enable alarm event only during the
period range which has been set.
1. Click fSetupoand the system will pop out the interface of AVorking
Perioda
2. Itis to set working period according to the following methods:
You can input time numerical value or press the left mouse button to
drag on the setup interface to set.
There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.
Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).
3. Click isaveoto complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0s to 100s.

Area

1. Click fSetupoand the system will pop out the interface of fSet Areaa

2. Setthe area name, it is to set the valid area of motion detection
according to the actual situation, and it can set its sensitivity and
threshold respectively. The higher the sensitivity is, the easier it is to
trigger motion detect, the smaller the area threshold is, the easier it is
to generate motion detect, the whole video image is the valid area of
the motion detect by default.

Note:

Different colors represent different areas; each area can set different

detection areas.

The red line in the Oscillogram means triggering motion detect, the green

line means not triggering motion detect.

3. Click fsaveoto complete area setup.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm a'udi'o f~iIe when alarm occurs. Use_
can set the recorded or uploaded audio fileinfi ¢ a me r a | saediot i 1
alarm audioa

Flash linkage Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.
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Parameter Function
PTZ Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detection
snapshot file. You shall set snapshot period in Storage>Schedule.
Step 5

Click fSaveoto complete the setting of motion detection.

5.3.1.2 Video Tampering
Step 1
Select fiSetup > Event > Video Detection > Video Tamperingoand the system will display the interface of
fVideo Tamperingdwhich is shown in Figure 5-66.

Camera
Network

> Audio Detection
> Smart Plan

> Vs

> Face Detection
> People Counting
> HeatMap

> Alarm

> Abnormality

Storage

System

Information

Motion Detection jvideo Tampering] Scene Changing

[] Enable Video Tampering

Working Period
[v] Record

Record Delay 10 Second (10~300)
[v] Relay-out

Alarm Delay 10 Second (10~300)

[] Send Email

[”] Snapshot

Default | | Refresh I | Save

[ Enable Defocus Detection

Figure 5-66
Step 2
Set the parameter of video tampering; please refer to the following sheet for more details.
Parameter Function
Enable video You need to check the box to enable video mask detection alarm.
tampering

detection

Enable defocus

You need to check the box to enable defocus detection alarm.
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Parameter Function
Note:

Working Period : L. .
It is to set the alarm period, it can enable alarm event only during the

period range which has been set.
1. Click fSetupoand the system will pop out the interface of AVorking
Perioda
2. Itis to set working period according to the following methods:
You can input time numerical value or press the left mouse button to
drag on the setup interface to set.
There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.
Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).
3. Click isaveoto complete the setup of working period.
Check it and so when alarm occurs, system will auto record. You shall set

Record
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs. Use
can set the recorded or uploaded audio fileinfi c a me r a , saediot i 1
alarm audioo .

Flash linkage Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.
PTZ > Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.
You need to check the box here so that system can backup motion detection
snapshot file. You shall set snapshot period in Storage>Schedule.

Snapshot

Step 3
Click isaveoto complete the setup of video tampering.

5.3.1.3 Scene Changing

Step 1

Select fSetup > Event > Video Detection > Scene Changingdand the system will display the interface of
fScene Changingowhich is shown in Figure 5-67.
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@hua
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> Face Detection V] Relay-or
> People Counting
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Step 2
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Step 3

Figure 5-67

e the function of scene changing.

It is to set the parameters of scene changing, please refer to the following sheet for more details.

Parameter

Function

Working Period

Note:
It is to set the alarm period, it can enable alarm event only during the
period range which has been set.
1. Click fSetupoand the system will pop out the interface of AVorking
Perioda
2. ltis to set working period according to the following methods:
You can input time numerical value or press the left mouse button to
drag on the setup interface to set.
There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.
Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).
3. Click isaveoto complete the setup of working period.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when

alarm occurs and ends. User can set email address in Network>SMTP.
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Parameter Function

PTZ > Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detection
snapshot file. You shall set snapshot period in Storage>Schedule.

Step 4
Click fSaveoto complete the setup of scene changing.

5.3.2 Audio Detection
Step 1

Select fSetup > Event > Audio Detectionoand the system will display the interface of fAudio
Detectionowhich is shown in Figure 5-68.

@Jhua

Camera Audio Detection
Network

Event [C] Enable Input Abnormal
> Video Detection -
[] Enable Intensity Change

> Smart Plan Sensitivity 8] O 2
> VS Threshold = 0 50
> Face Detection
> People Counting
> HeatMap
> Alarm
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:Z:::‘e Working Period -Semp
Information PR 5 Second (0~100)

[¥] Record

Record Delay 10 Second (10~300)
[V] Relay-out
Alarm Delay 10 Second (10~300)
[C] Send Email
[”] Snapshot
Default ] l Refresh I ‘ Save
Figure 5-68

Step 2

It is to set the parameters of audio detect, please refer to the following sheet for more details.

Parameter Function

Enable input Select fEnable Input Abnormaldand it will trigger alarm when it detects
abnormal audio input abnormity.

Enable intensity | Select fEnable Intensity Changeoand it will trigger alarm when it detects
change that audio intensity change exceeds the threshold.
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Parameter Function
Sensitivity It can be judged as audio abnormity when the input volume change
exceeds continuous environment volume; users need to adjust according
to the actual environment test.
Threshold It is to set the filtered environment volume intensity, if the environmental

noise is too big, then the value needs to be set higher, users can adjust
according to the actual environment test.

Working Period

Note:
It is to set the alarm period, it can enable alarm event only during the
period range which has been set.
1. Click fSetupoand the system will pop out the interface of AVorking
Perioda
2. Itis to set working period according to the following methods:
You can input time numerical value or press the left mouse button to
drag on the setup interface to set.
There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.
Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).
3. Click fsaveoto complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0s to 100s.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
PTZ Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detection
snapshot file. You shall set snapshot period in Storage>Schedule.
Step 3

Click isaveoto complete the setup of audio detection.
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5.3.3 Smart Plan
Smart plan is the master switch for intelligent analysis suchasfiFac e Def He & i cofiM adpS

APeopl e &oamd isnng on, the correspondi maftersmartplanlisi i gen't
enabled.

Step 1

Selectih Set up > Evend. >TienagystPdmnwi | | Adimap Itog P Iwdmec hi nitse

shown in Figure 5-69.

alhua [ uve [ Papsck | sewp | mam | Logow ]
Camera Smart Plan @
Network

> Video Detection
> Audio Detection

_ SmartPlan "

> Iv8

> Face Detection

> People Counting I Refresh || Sao

> HeatMap

> Alarm
> Abnormality

Storage

System

Information

Figure 5-69
Step 2
Clickih Saovet o compl ete the config of smart pl an.

5.3.4 Intelligence Behavior Analytics
The basic requirements of scene selection.
> The total proportion of the target shall not exceed 10% of the image.

5

The target size in the image cand be less than 10 pixel | 10 pixel, the size of abandoned target
cand be less than 15 pixel | 15 pixel (CIF image); The height and width of the target cand exceed
1/3 of the image,; it is recommended that the target height is about 10% of the image height.

: The difference of brightness value between target and background cand be less than 10 gray levels.
Make sure the target appears at least over 2 seconds continuously in the field; the movement
distance has to be bigger than the width of the target itself and makes sure it is no less than 15
pixels (CIF image).

Tr\éto lower the complexity of the monitoring scene analysis if it is possible; it is not advised to use
IVS functions in the environment where the targets are dense and light change is very frequent.

Try to keep away from the areas such as glass, ground reflected light, water surface, branch,
shadow, mosquito disturbance and etc. try to keep away from the backlight scene to avoid direct
light.
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5.3.4.11IVS

5.3.4.1.1 Tripwire

It will trigger alarm when the target crosses the warning line according to the movement direction which
has been set.

It needs some time from when the target appears to when the target is confirmed, so it has to leave
some space on both sides of the warning line when setting the warning line, please do not set the
warning line near the obstructions.

Application scene: it can be applied to the scene with sparse target and there is barely any

blocks between the targets, such as the unmanned perimeter defense. Step 1

Select fSetup > Event > IVS > IVSoand the system will display the interface of AVSa
Step 2

Click (‘)to set rule name and select the rule type as ATripwiredwhich is shown in Figure 5-70.

@lhua

Camera

Network
No. Rule Name Rule Type

; Y 1 Rulet Tripwire

> EventManage
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> Audio Detection
> SmartPlan

— 3¢ L ;
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> Alarm
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storage | Record

System N— . Record Delay Second (10~300)

e — | Relavout

TargetFilter (® MaxSize 8191 * 8191 Draw Target Alarm Delay Second (10~300)
; | Send Email
Mses 0 0

¢! Snapshot

| Default H Refresh H Save

Figure 5-70
Step 3
Click fDraw Ruleoto draw tripwire in the monitoring scene, click the right mouse button to complete
tripwire setting.
Step 4
Clicki Dr aw dargedraw the size model of filtered targe!
Step 5
It is to set the parameters of tripwire, please refer to the following sheet for more details.
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Parameter Function
Object tracking | Select fDbject trackingoto enable the function, refer to 2.4 Video Window
Adjustmentofor more details.
Note:
The function is only supported by some models.
Note:

Working Period

It is to set the alarm period, it can enable alarm event only during the period
range which has been set.
1. Click fisetupdand the system will pop out the interface of ANorking
Perioda
2. ltis to set working period according to the following methods:
You can input time numerical value or press the left mouse button to
drag on the setup interface to set.
There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.
Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).
3. Click fsaveoto complete the setup of working period.

Direction

It is to set the direction of tripwire, you can select A->Ba B->Aa A<->B.

Object Track

Selecti Ob j e c ® diitrwal enlable the function of object track; when the
moving object triggers rule and generates alarm, it will select the display
mode of object track such as 1P+3 or 1P+5 in the preview interface, the
scene of tracking window will follow the moving object till the object leaves
the view range of the camera. Pleaserefertoi 2. 4. 8 Fi s h e yoe
for more details.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select fSnapshotoand the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click fBaveoto complete the setup of tripwire.

5.3.4.2 Intrusion

Intrusion includes cross and appears.
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> Cross means that it will trigger alarm when the target enters or exits the area.

Appears means that it will trigger alarm when the target appears in the area.

same event

event happened in the interval.

It needs to leave some space for target movement for the area periphery if it is to detect enter & exit

event, which is similar to the warning line.
Application scene; it can be applied to the scene where the target is sparse and there is barely any

obstruction between the targets, such as the unmanned perimeter defense. Step 1

Select fSetup > Event > IVS > IVSoand the system will display the interface of AVSa

Step 2

Click (‘)to set rule name, select the rule type as fintrusionowhich is shown in Figure 5-71.
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Step 3

Figure 5-71

Click fDraw Ruleoto draw an area in the monitoring image.

Step 4
Click i [aw Targeto
Step 5

It is to set the parameters of intrusion, please refer the following sheet for more details.
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Parameter Function
Object tracking | Select fDbject trackingoto enable the function, refer to 2.4 Video Window
Adjustmentofor more details.
Note:
The function is only supported by some models.
Note:

Working Period

It is to set the alarm period, it can enable alarm event only during the period
range which has been set.
1. Click fisetupdand the system will pop out the interface of ANorking
Perioda
2. ltis to set working period according to the following methods:
You can input time numerical value or press the left mouse button to
drag on the setup interface to set.
There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.
Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).
3. Click fsaveoto complete the setup of working period.

It is to set the action of intrusion, you can select appears and cross.

Action

Direction It is to set the direction of intrusion, you can select enter, exit and
enter&exit.

Object Track Selecti Ob j e c dandritrwal enlable the function of object track; when the
moving object triggers rule and generates alarm, it will select the display
mode of object track such as 1P+3 or 1P+5 in the preview interface, the
scene of tracking window will follow the moving object till the object leaves
the view range of the camera. Please refertoi 2 . 4. 8 Fi s h e yoe
for more details.

Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can sc_end out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select fBnapshotdand the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click fi5aveoto complete the setup of intrusion.
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5.3.4.3 Abandoned Object

Abandoned object means the system will trigger alarm if the abandoned object in the monitoring scene
exceeds the time which has been set by the users.

Abandoned object and missing object can be confusing in a situation where both foreground and
background are complicated.

It also triggers alarm as abandoned object if there is pedestrian or vehicle staying still for too long. In
order to filter this kind of alarm, generally the abandoned object is smaller than people and vehicle;
therefore it can filter the people and vehicle via setting size. Besides, it can avoid the false alarm
caused by short stay of people via extending alarm time properly.

Application scene: It can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene with high target density and frequent
blocking; false alarm will be increased in the scene where there are more people staying. As for the
detection area, try to make it simple, the function is not suitable for the area which is too complicated.
Step 1

Select fSetup > Event > IVS > [VSoand the system will display the interface of AVSa

Step 2

Click (‘)to set rule name, select the rule type as fiAbandoned Objectowhich is shown in Figure 5-72.

@lhua
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Figure 5-72
Step 3
Click fDraw Ruleoto draw an area in the monitoring area.
Step 4
Clickh Dr aw dargedraw the size model of filtered targef
Step 5

It is to set the parameter of abandoned object, please refer to the following sheet for more details.
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Parameter

Function

Working Period

Note:
It is to set the alarm period, it can enable alarm event only during the period
range which has been set.
1. Click fisetupoand the system will pop out the interface of ANorking
Perioda
2. Itis to set working period according to the following methods:
You can input time numerical value or press the left mouse button to
drag on the setup interface to set.
There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.
Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).
3. Click isaveoto complete the setup of working period.

Keep time

It is to set the shortest time from when the object is abandoned to when it
triggers alarm.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select iSnapshotoand the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click ifsaveoto complete the setup of abandoned object.

5.3.4.4 Missing Object

Missing object means the system will trigger alarm if it exceeds certain amount of time after the target is

taken away from the original scene.

The system can make statistics of the still areas in the foreground area and distinguish if it is missing
object or abandoned object according to the similarity between foreground and background, it will
trigger alarm when it exceeds the time which is set by users.

Because the system distinguishes abandoned object from missing object according to the similarity of
foreground and background, it may cause error between abandoned object and missing object in a
situation where both foreground and background are complicated.
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Application scene: it can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene where the target density is high and
there is frequent obstruction; the false alarm will be increased in the scene where there are more people
staying. As for the detection area, try to make it simple, the function is not suitable for the area which is
too complicated.

Step 1

Select fSetup > Event > IVS > IVSoand the system will display the interface of AVSa

Step 2

#loto set rule name and select rule type as fMissing Objectd which is shown in Figure 5-73.

Figure 5-73
Step 3
Click fDraw Ruleoto draw an area in the monitoring scene.
Step 4
Clicki Dr aw dargedraw the size modelimagd filtered targe!
Step 5

It is to set the parameters of missing object, please refer to the following sheet for more details.
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